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What is OpenType?
OpenType is a new cross-platform font file format devel-
oped by Adobe and Microso. Based on Unicode, Open-
Type is an extension of the TrueType  format that 
can now support PostScript® font data and new typo-
graphic features. OpenType fonts containing TrueType 
data have a .ttf or .ttc suffix in the font file name, while 
PostScript based OpenType fonts have an .otf file name 
suffix. is user guide deals primarily with the installa-
tion and use of OpenType .otf fonts.

OpenType fonts may include an expanded character set 
and layout features to provide richer linguistic support 
and advanced typographic control. Feature-rich Adobe 
OpenType fonts with support for central European (CE) 
languages can be distinguished by the word “Pro,” which 
is part of the font name and appears in application 
font menus. OpenType fonts that do not contain cen-
tral European language support are labeled “Standard,” 
and are designated by an “Std” suffix in the fonts’ menu 
names. All OpenType fonts can also be installed and 
used alongside PostScript Type 1 and TrueType fonts.

One Cross-Platform Font File

All OpenType fonts use a single font file for all of their 
outline, metric, and bitmap data, making file manage-
ment simpler. e file names for Adobe’s OpenType 
fonts are clearly descriptive. In addition, the same font 
file works on Macintosh and Windows computers, 
improving cross-platform portability for documents.

Better Language Support

Based on Unicode, an international multi-byte char-
acter encoding that covers virtually all of the world’s 
languages, OpenType fonts can make multilingual 
typography easier by including multiple language char-
acter sets in one font. All Adobe OpenType fonts include 
the standard range of Latin characters used throughout 
the western world, and several international charac-
ters, including the euro currency symbol (), “estimated” 
(), and litre (ℓ). Adobe’s OpenType Pro fonts add a 

full range of accented characters to support central and 
eastern European languages, such as Turkish and Polish. 
Many of the Pro fonts also contain Cyrillic and Greek 
character extensions in the same font.

Advanced Typography with OpenType Pro fonts

OpenType fonts may also contain more than , 
glyphs, unleashing exciting typographic capabilities.  
Many non-standard glyphs, such as oldstyle figures, true 
small capitals, fractions, swashes, superiors, inferiors, 
ornaments, titling letters, contextual and stylistic alter-
nates, beginning and ending letterforms and a full range 
of ligatures may also be included in a single font. In the 
past, a typical Western PostScript font was limited to  
glyphs, forcing users to install and manage two or more 
style-related fonts in order to access “expert” or other 
supplemental characters. OpenType significantly simpli-
fies font management and the publishing workflow by 
ensuring that all of the required glyphs for a document 
are contained in one cross-platform font file throughout 
the workflow.

Historically, some of the highest-quality typefaces have 
had different designs for different print sizes. Called 

“opticals,” these variations have been optimized for use 
at specific point sizes. A number of Adobe’s OpenType 
fonts include four optical size variations: caption, regular, 
subhead and display. Although the exact intended sizes 
vary by family, the general size ranges include: caption 
(- point), regular (- point), subhead (- point) 
and display (- point).

Unbelievable  Caption

Unbelievable  Regular (Text)

Unbelievable  Subhead

Unbelievable  Display  

Macintosh Windows
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Overall, OpenType provides richer support for the 
world’s languages, more powerful typographic capa-
bilities, better cross-platform compatibility, as well as 
simplified font management. For more information 
on OpenType, please refer to the Adobe web site at 
www.adobe.com/type/opentype.

Minimum System Requirements 
for OpenType .otf Fonts

Macintosh
 • Macintosh with PowerPC® processor
 • Mac OS 8.6 to 9.2 or Mac OS X
 • ATM® Light or Deluxe, version 4.6 or later
   (not required for Mac OS X native)
 • AdobePS printer driver 8.6 or later recommended
   if using a PostScript printer with Mac OS 8.6 or 9
 • 16 MB of RAM

Windows
 • PC using a Pentium® or compatible processor
 • Microso Windows® 95, 98, Millennium Edition (ME),
    Windows NT® 4, Windows 2000 or Windows XP
 • ATM Light or Deluxe 4.1 or later
   (not required for Windows 2000/Windows XP)
 • AdobePS printer driver 4.3 or later, if using 
    Windows 95/98/ME with a PostScript printer
 • AdobePS printer driver 5.1.2 or later, if using 
    Windows NT 4 with a PostScript printer
 • 16 MB of RAM

Note: Mac OS X, Windows 2000 and Windows XP (Home 
and Professional) provide native support for OpenType 
.otf fonts (as well as PostScript Type 1 fonts) and do not 
require ATM Light or the AdobePS printer driver.

Additional Software Installation
Before using your OpenType .otf fonts, you may need 
to install the latest versions of the Adobe Type Man-
ager Light soware and the AdobePS printer driver, 
which are both available as free downloads from the 
www.adobe.com website.

Adobe Type Manager (ATM) Light

Adobe® Type Manager® (ATM®) Light is a 
system soware component that automati-

cally generates high-quality screen font bitmaps from 
PostScript® Type 1 or OpenType .otf outline font data. 
With ATM, you can use Type 1 and OpenType fonts at 
any size, and you can also enable “font smoothing,” (anti-
aliasing) which further improves the appearance of your 
fonts on-screen. ATM Light also allows you to print 
your PostScript Type  or OpenType .otf fonts to both 
PostScript and non PostScript printers.

Note: Windows 2000 and Windows XP do not require 
ATM Light. Mac OS X only needs ATM Light to pro-
vide support for “Classic” applications, not for Carbon or 
native applications. 

To download ATM Light, point your browser to: 
http://www.adobe.com/products/atmlight/main.html

Note: It is recommended that once you install ATM Light, 
you increase the utility’s character cache setting (the 
amount of memory allocated for storing font informa-
tion and drawing it to your computer screen) to at least 
512K in the Windows version, and to at least 1MB in the 
Macintosh version. To increase this setting in the Win-
dows version, select the “Settings” tab in the ATM window. 
On the Macintosh, it is in the main control panel for ATM 
Light; in ATM Deluxe, select the “Preferences…” command 
in the File menu.

AdobePS Printer Driver

If you are printing to a PostScript printer or 
creating PostScript print files (perhaps for 

Adobe Acrobat Distiller), the AdobePS printer driver 
replaces your standard Mac or Windows printer driver 
and offers several improvements. Installation of this 
driver requires a PostScript Printer Description (PPD) 
file for your printer, which allows the driver to con-
trol all of your printer’s features, such as optional paper 
trays, enhanced imaging modes, and duplex (two-sided) 
printing. More instructions are included in the Read Me 
file that comes with the AdobePS soware. 

To download the latest AdobePS printer driver 
for the Macintosh, point your browser to http://
www.adobe.com/support/downloads/pdrvmac.htm

To download the latest AdobePS printer driver for Win-
dows, point your browser to http://www.adobe.com/
support/downloads/pdrvwin.htm

Note: Mac OS X, Windows 2000 and Windows XP 
include a native PostScript printer driver that supports 
OpenType .otf fonts.
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Installing OpenType .otf Fonts
All the information required for Adobe OpenType fonts 
is contained in a single file with an “.otf ” suffix at the 
end of the filename. is font file is a cross-platform file, 
and can be installed on both the Macintosh and Win-
dows platforms. 

Installing on Mac OS

Using your fonts on Mac OS . to . or Mac OS X 
“Classic” requires the presence of ATM Light . or later 
(.. for Mac OS X Classic). Mac OS X has built-in sup-
port for OpenType fonts with carbon or native applica-
tions, and only requires ATM Light for “classic” apps. 

If you are running Mac OS X, decide if you want to 
install fonts into both the Classic environment and the 
OS X native environment, or only for carbon/native 
applications. If you want your fonts to be accessible to 
both Classic and carbon/native applications, install into 
the Classic environment. If the fonts only need to be 
accessible to carbon/native applications, install into the 
Mac OS X “native” environment.

Mac OS 8.6 to 9.2, or Mac OS X “Classic”

1 Before installing your OpenType fonts, quit all active 
applications.

2 Locate the folder that contains the OpenType fonts 
you want to install. 

 If you have purchased Adobe OpenType fonts online, 
they will have been decompressed to a folder on your 
hard drive. If you have purchased multiple font pack-
ages, each will have its own folder.

3 Copy or move all the OpenType font files from their 
individual font folders into the System Folder > Fonts 
folder. ey must be loose inside this folder, not in a 
sub-folder.

e fonts are now installed and will appear in the font 
menus of your applications. OpenType fonts installed in 
Mac OS X Classic will also appear in the font menus of 
native and Carbon applications

Mac OS X native

Mac OS X has built-in support for OpenType .otf fonts. 
You do not need to install ATM Light to use fonts in the 
Mac OS X native environment, only for the Classic envi-
ronment.

Fonts installed under the Mac OS X native environment 
will only by available to carbon and native applications 
running in OS X (not classic applications). Depending 
on how they are installed, they can be accessed by (a) 
any user or (b) just by an individual user.

1  Before installing your OpenType fonts, quit all active 
applications.

2 Locate the folder that contains the OpenType fonts 
you want to install. 

 If you have purchased Adobe OpenType fonts online, 
they will have been decompressed to a folder on your 
hard drive. If you have purchased multiple font pack-
ages, each will have its own folder.

3 Copy or move all the OpenType font files from their 
individual font folders into either of the following 
locations. (Note that the fonts must be loose in the 
destination folder, not in a subfolder.)

 (a) <Volume>/Library/Fonts/
Note: you must be logged on as an “Administrator” to 
place fonts in this location. Fonts in this location can 
be used by any user.

 (b) <Volume>/Users/<username>/Library/Fonts/
Note: fonts in this location can be used only by the 
specified user.

e fonts are now installed and will appear in the font 
menus of Carbonized or native applications.

Installing on Windows

Installing your fonts on Windows 95/98, ME or NT 4 
requires ATM Light 4.1 or later. Windows 2000 and XP 
have native support for OpenType fonts; you can use 
the operating system’s Fonts control panel to install or 
remove new OpenType fonts.

Windows 95/98/ME or NT 4 with ATM Light

1  Choose Start > Programs > Adobe > Adobe Type 
Manager.

2  In the ATM window, click the “Fonts” tab.

3  Choose “Browse For Fonts” from the Source pop-up 
menu.

4  Navigate to the folder that contains the fonts you 
want to install. e fonts located in a folder will 
appear below the folder’s name.
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 Adobe OpenType fonts purchased online will be in 
the location you decompressed them to.

5  Select the fonts you want to install. You can click to 
select one font, Control-click to select several fonts, 
or Shi-click to select a contiguous group of fonts.

6  Press the “Add” button to install the fonts.

7 Exit ATM.

 e fonts are now installed and will appear in the 
font menus of your applications.

Windows 2000 and Windows XP

Windows 2000 and Windows XP (Home and Profes-
sional) have built-in support for PostScript Type 1 and 
OpenType fonts (both .otf and .ttf). Unless you wish to 
use multiple master fonts, ATM Light is not required 
on these OSes. Use the Windows Fonts control panel to 
install all PostScript Type 1, TrueType, and OpenType 
fonts.

1  Double-click on “My Computer.” en double-click 
on the “Control Panels” icon, and then the “Fonts” 
icon.

2  In the Fonts window, select the File menu, and 
choose “Install New Font.”

3  Navigate to the folder that contains the fonts you 
want to install.

 Adobe OpenType fonts purchased online will be in 
the location you decompressed them to.

4  Select the fonts you want to install. You can click to 
select one font, Control-click to select several fonts, 
or Shi-click to select a contiguous group of fonts.

5  Press the “OK” button to install the fonts.

6  Close the Fonts control panel when you are finished.

 e fonts are now installed and will appear in the 
font menus of your applications.

Removing OpenType .otf Fonts

Mac OS (all versions)

1  Open the folder you installed the fonts into.

2  Drag the OpenType font files that you want to 
remove out of the folder and into a non-system 
folder or into the Trash.

Windows 95/98/ME or NT 4

1  Choose Start > Programs > Adobe > Adobe Type 
Manager.

2  In the ATM window, click the Fonts tab.

3  Select the fonts you want to remove. You can click to 
select one font, Control-click to select several fonts, 
or Shi-click to select a contiguous group of fonts. 
You may also elect to copy the fonts to another loca-
tion before deleting them.

4  Press the “Delete” button to remove the fonts.

5  Exit ATM.

Windows 2000 or Windows XP

1  Double-click on “My Computer.” en double-click 
on the “Control Panels” icon, and then the “Fonts” 
icon.

2  In the Fonts window, select the Fonts you want to 
remove, and choose “Delete” from the file menu. You 



OpenType User Guide6 OpenType User Guide 7

can click to select one font, Control-click to select 
several fonts, or Shi-click to select a contiguous 
group of fonts. You may also elect to copy the fonts to 
another location before deleting them.

3  Close the Fonts control panel when you are finished.

OpenType and Font Management 
Utilities
Because OpenType .otf fonts are a new format, please 
check to make sure that the current version of your font 
management application supports OpenType .otf fonts. 
If you are using ATM Deluxe to manage your fonts, ver-
sion 4.1 or higher for Windows and version 4.6 or higher 
for Macintosh support the activation and management 
of OpenType fonts. If you are using Extensis Suitcase, 
version  on Mac OS X manages OpenType fonts for 
Carbon and native applications. For further instructions 
on how to install OpenType fonts with ATM Deluxe or 
any other font management application, please refer to 
your font management application’s documentation.

Unicode and Access to Foreign 
Language Characters & Symbols
Applications and operating systems that make use of the 
Unicode standard for text processing can provide easy 
access to the wide range of accented characters and spe-
cial symbols in Adobe OpenType fonts, greatly simplify-
ing multilingual typesetting.

In environments where the operating system and ATM  
combination does not fully support Unicode (such as 
Windows 95/98/ME or Mac OS 8 and 9), applications 
will generally only have access to a single-byte encod-
ing—essentially the first  characters—of an Open-
Type .otf font. e only exceptions are applications 
which provide their own font and Unicode support, 
such as Adobe InDesign and Photoshop. 

Unicode support in Applications

e operating system, sometimes aided by ATM, pro-
vides access to the characters of OpenType fonts for 
applications. In some cases, an application will provide 
its own basic character support (Adobe InDesign does 
this).

What is covered by basic character set access depends 
on the application as well as the operating system. For 
applications that support Unicode, such as Adobe 
InDesign, this basic character access may cover any 
language supported by the font. Applications that don’t 
support Unicode can still access and print the basic  
characters of western languages—the Win-ANSI (code-
page ) or MacRoman range—although the fonts 
themselves may support additional languages.

OpenType fonts which are strictly ”pi” or symbolic fonts 
may not have any characters in the Win-ANSI or Mac-
Roman range. With such a pi font, if an application does 
not support Unicode, then none of the characters of the 
font would be accessible in the application.

All the Unicode-encoded glyphs in an OpenType font 
will show up in the Windows NT , Windows  and 
Windows XP Character Map accessory, allowing direct 
copying and pasting of any OpenType glyphs into any 
application that supports Unicode. On Mac OS X, one 
can install and select a Unicode keyboard that allows 
direct access to any Unicode character, within most 
applications that support Unicode.

Switching between the character sets of the different 
languages supported by Adobe OpenType fonts can be 
as simple as changing the current keyboard language 
setting. is kind of  “on-the-fly” keyboard switching 
with OpenType is supported by Windows NT 4, Win-
dows 2000, Windows XP and Mac OS X. Addition-
ally, the Windows NT, Windows 2000, and Windows 
XP “Character Map” accessory is Unicode-aware, and 
allows you to directly access any encoded character in 
an OpenType font.

Language switching in Adobe applications

In some current-generation Adobe applications, Uni-
code and language support are handled independently 
of the operating system. InDesign . and Photoshop 
, for example, support direct keyboard input of a wide 
range of languages, including Greek, Cyrillic, and other 
central and eastern European languages.

Adobe InDesign offers additional options for text input. 
All versions of InDesign support import of Unicode text 
files and Microso Word for Windows files containing 
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Unicode. Additionally, as described below, InDesign’s 
Glyph Palette allows access to any glyph in the font, 
even glyphs that are unencoded and not accessible in 
the Windows Character Map.

Application Support for 
Advanced OpenType Features

Characters and Glyphs

e distinction between characters and glyphs is central 
to a discussion of advanced OpenType layout feature 
support. Characters are the code points assigned by the 
Unicode standard, which represent the smallest seman-
tic units of language, such as letters. Glyphs are the spe-
cific forms or shapes that those characters can take in a 
font.

A key point is that one character may be represented by 
any of several different glyphs. For example, lowercase 

“a,” small cap “a” and an alternate swash lowercase “a” are 
all the same character—namely the lowercase “a”—but 
they are three separate glyphs.

Additionally, although the relationship between glyphs 
and characters is oen one-to-one, it may be many-
to-one, one-to-many, or many-to-many. For example, 
sometimes several characters may be represented by 
one glyph, as in the case of the “ffi” ligature, which cor-
responds to a sequence of three characters: f, f and i. 
Alternately, one character may be represented by several 
glyphs. For example, “é” is oen considered a single char-
acter, but might be assembled on the fly from separate 
glyphs for the base character and the accent.

OpenType layout features can be used to position or 
substitute glyphs. For any character, there is a default 

glyph and positioning behavior. Applying layout fea-
tures to one or more characters may change that default 
positioning or substitute a different glyph. For example, 
the application of the “small capitals” feature to the “a” 
would substitute the small cap “a” glyph for the usual 
lowercase “a” glyph.

OpenType Layout features

To access alternate glyphs or apply alternate positioning 
with an OpenType font, an application must understand 
OpenType layout features and present a user interface 
that allows end users to select and apply different layout 
features to text.

OpenType and Adobe Applications
InDesign, Adobe’s flagship page layout program, was 
the first Adobe application to provide OpenType layout 
feature support. Photoshop also supports a number 
of OpenType layout features, and other Adobe appli-
cations that support text formatting are expected to 
follow suit in the future. With InDesign, Photoshop and 
other OpenType-savvy applications, you can turn on 
OpenType layout features that automatically substitute 
alternate glyphs in an OpenType font, such as automatic 
ligatures, small capitals and proportional oldstyle fig-
ures.

Adobe InDesign . expands InDesign’s previous 
OpenType layout feature support, simplifying the use 
of professional typographic features once considered 
cumbersome, and providing exciting new typographic 
capabilities.

While some layout features that work with multiple font 
formats (all caps, small caps, and ligatures) are on the 
main flyout from the InDesign character palette, most 
of InDesign .’s OpenType layout features are accessed 
by the OpenType sub-menu of the character palette 
flyout. ere are  formatting options on this sub-menu, 
including discretionary ligatures, swashes, fractions, and 
four different types of figures, which are discussed in 
detail below.

To apply OpenType layout features 

1  Insert your cursor in a text box to apply the feature 
to new text, or select existing text you wish to format.

2  Select an OpenType font from the Character palette 
or via the Type > Font menu.

3  In the Character palette, click on the triangle in the 
top right corner of the palette to open the flyout 
menu that lists possible formatting options. 

4  Either select a formatting item on the main flyout 
that may activate OpenType features, or select the 

aa a a

Although this section 

focuses on InDesign 

., it also provides 

information relevant 

for Photoshop  and 

InDesign .x. 
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OpenType sub-menu, and a formatting option on 
that sub-menu. 

      A check mark will appear next to a feature that is 
turned on. If the OpenType font has the desired fea-
ture and glyphs, it will be applied. Remember that not 
all fonts have all OpenType layout features, and that 
some features work only on certain characters.

     For example, text with the “Discretionary Ligatures” 
feature turned on will automatically replace certain 
character combinations such as “ct” or “st” with a liga-
ture such as “” or “st.”

If an OpenType layout feature appears in brackets [like 
this], then the currently selected font does not support 
that particular feature. To gain a better understanding of 
the features supported in each OpenType font, you can 
use the Glyph Palette to view the glyphs available for 
each feature (see section below).

A dash next to an advanced OpenType layout feature 
means that you have selected a block of text that has an 
OpenType layout feature applied to some of the text. A 
check mark will appear next to a feature that is turned 
on for all the selected text.

ere are three InDesign features which have an effect 
on non-OpenType fonts, but do more with OpenType 
fonts that have relevant layout features. ese features—
ligatures (which are on by default), all capitals, and small 
capitals—are directly accessible from the main flyout 
of the InDesign character palette. Photoshop  and 
InDesign .x have no OpenType sub-menu, and also put 
proportional oldstyle figures on the main menu.

In InDesign ., these typographic features are included 
on the main pop-up menu because they can sometimes 
be used with non-OpenType fonts. See the individual 
feature descriptions for details.

Note: In Adobe InDesign, selecting the Superscript and 
Subscript options on the Character palette’s main flyout 
will create these glyphs by scaling full-size numbers, even 
if the selected font contains designed superscript/subscript 
glyphs. To access designed glyphs contained in an Open-
Type font, you should instead use the “Superscript/
Superior” and “Subscript/Inferior” features on the Open-

Type flyout menu. See the feature descriptions below for 
details.

OpenType Layout Feature Descriptions

Below are descriptions of the OpenType layout features 
supported by Adobe applications, and guidance on how 
and when to use these features. InDesign . supports 
all the listed features; Photoshop  and InDesign . sup-
port all caps, small caps, proportional oldstyle figures 
and standard ligatures.

Some effects similar, but inferior to, OpenType layout 
features can be created synthetically by scaling regu-
lar-size glyphs. Because these effects do not use real, 
designed glyphs, these are referred to as “faux” effects 
(faux is a French word meaning “false”). Layout features 
which may have faux equivalents include small caps, 
fractions, ordinals, superscript/superior, subscript/infe-
rior, numerators and denominators. For the best results, 
whenever possible you should access real designed 
glyphs via OpenType layout features.

All Caps: With both OpenType and other fonts, this 
formats the text in uppercase. With OpenType fonts, it 
also applies OpenType features for alternate uppercase 
positioning of punctuation, and spacing designed for 
all-cap use.

typed uppercase ¿QUE? ‹ROMA-PARIS› 
formatted all caps QUE? ROMAPARIS

Small Caps: With both OpenType and other fonts, this 
formats lowercase text as small caps. (Note: compare 
with  “All Small Caps” feature below.) If the font has 
OpenType small caps, these will be used. If the font has 
a companion Expert Set font, InDesign may be able to 
tell that the font is associated with the base font, and use 
the small caps from the Expert font. In all other cases, 
small caps are synthesized from capital letters. Observe 
how these “faux” small caps look light and spindly next 
to the capitals, while the designed small caps match the 
appearance of their full-size siblings.

faux small caps LIFE IS BUT A POOR PLAYER

real small caps L I B A P P
Ligatures: is activates any standard ligatures in an 
OpenType font (ligatures that the type designer suggests 
should be customarily used). In an OpenType font, these 
can be any ligatures the type designer chose to create. 
e major reason for standard ligatures is to avoid awk-
ward collisions between letters, creating more elegant 
text (see example below). Standard ligatures are on by 
default in InDesign and Photoshop.

In non-OpenType fonts, this will activate any of the 
basic f-ligatures that are in the font. I many fonts, this 
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is only the fi and fl ligatures, though InDesign may also 
recognize the ff, ffi and ffl ligatures if they are present.

Many Adobe Pro fonts include a large set of standard 
ligatures, such as fi, fl, ffi, ffl, ff, , , , and others. Most 
other Adobe OpenType fonts have a smaller set of stan-
dard ligatures, like those in Type  fonts.

without ligatures This office fjord halfb
with ligatures is office ord hal

Discretionary Ligatures: In Indesign ., this activates 
discretionary and historical ligatures, both of which 
should be used sparingly for special effects. ese liga-
tures may include , , st, and several historical “long 
s” ligatures such as . Only select OpenType fonts have 
discretionary and historical ligatures.

without disc. lig. Most eſſential effects
with disc. lig. Most eential effes

Fractions: Turns on fractions. Some Adobe OpenType 
fonts only have three basic pre-built fractions (1⁄2, 1⁄4, 3⁄4), 
while others have a larger set, oen including 1⁄8, 3⁄8, 5⁄8, 
7⁄8, 1⁄3 and 2⁄3. e extent of pre-built fractions may vary 
between fonts. Select OpenType fonts can also support 
any arbitrary fraction such as ⁄ or ⁄. In all 
these cases, these designed fractions match the weight 
of the rest of the font better than fractions which are 
fauxed by scaling regular-size numbers.

Note: You should only apply the fraction feature to the 
specific text you want to turn into a fraction. Apply-
ing the fraction feature to other numbers may result in 
unexpected effects—either initially, or later if the text is 
switched to a different font with a  different implementa-
tion of fractions. 

faux fractions 1⁄8  1⁄2 22⁄7   11⁄12  81,234⁄4,567

real fractions 1⁄8 31⁄2 ⁄ 5⁄ 8 ⁄
Ordinals: Contextually switches regular glyphs to 
designed superscripted glyphs, such as the “st”’ in , 

“nd” in ⁿ, and so on. Virtually all Adobe fonts have the 
masculine and feminine ordinals required for Spanish 
segunda/segundo (ª, º), but not all have the full set 
of superscripted glyphs needed for English ordinals. In 
Adobe’s OpenType fonts,  the No (number) character and 
the “h” required for ordinals such as “” are generally 
present only in Pro fonts.

Some applications, such as word processors, can auto-
matically synthesize ordinals by scaling regular let-
ters. As always, real designed ordinal glyphs are a better 
match for the full-size numbers than the faux ordinals 
created by simple scaling.

faux ordinals st nd rd th a o

real ordinals  ⁿ   ª º
Note: Because some ordinal combinations may occur in 
normal text (such as “No” in “None”), the ordinal feature 
should not be applied globally, but only where needed. 
Also, because of their constant vertical position, ordinals 
work best with lining figures, rather than oldstyle figures. 

Swash: substitutes swash glyphs (stylized letterforms 
with extended strokes; see below). Even if this feature is 
globally turned on, it may only apply swashes in certain 
cases, such as when a character is at the end of a word. 
Swashes should be used sparingly for special effect. Only 
select OpenType families contain swash glyphs, and in 
families which do contain swash glyphs, they are oen 
present only in the italic faces within the family.

without swash  Aidan  Sue    Veronica
with swash ida  u  eronic

Titling Alternates: substitutes specially-designed glyphs 
to be used for large-size settings such as titles, usually 
all in capitals. Only select Adobe OpenType fonts have 
titling alternates.

without titling FINESSE   BEAUTY
with titling    

Contextual Alternates: substitutes alternate glyphs and 
ligatures that only occur depending on what letters are 
nearby. is feature is on by default in InDesign .. 
Contextual forms can have striking effect in those select 
OpenType fonts that make use of them. For example, 
Caflisch Script Pro (below) uses contextual forms to 
create variety and a realistic calligraphic handwriting 
appearance.

without contextual new azaleas bloom where
with contextual  les l r

All Small Caps: Unlike the traditional small caps feature, 
which only turns lowercase into small caps, this substi-
tutes small capitals for all characters typed or selected, 
including uppercase as well as lowercase letters.

All small caps should be used instead of small caps 
whenever the underlying text is uppercase, as with cer-
tain acronyms and abbreviations such as , , 
,  or . (See also “Small Caps,” previous.)

Superscript/Superior: substitutes designed super-
scripted glyphs. ese designed glyphs match the weight 
of the regular letters and numbers better than synthe-
sized (faux) superscript glyphs. Note that the select 
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Adobe OpenType fonts which support this feature do 
not have all characters available in superscript form. 
Instead, they generally have the letters “ⁿ,” plus 
a full set of numbers and basic punctuation. Pro fonts 
generally add the “” as well. is subset of the alphabet 
represents all the characters needed for ordinals and 
common superscripting needs in western languages.

faux superscript x14y37   πr2   4a

real superscript x¹⁴y³⁷   πr²  4

Subscript/Inferior: Much like superscript (above), but 
for subscripted characters. However, the select Adobe 
fonts which support subscripts generally have only 
numbers and punctuation, with no letters.

faux subscript H20  CH4  n37

real subscript H₂0  CH₄  n₃₇

Numerator: substitutes designed numerator glyphs (the 
top part of a fraction) for numbers. ose Adobe Open-
Type fonts that support this feature generally have a full 
set of digits and basic punctuation in numerator form. 
However, it is generally more convenient to simply apply 
the fraction feature.

Denominator: Just like numerators, but for denomina-
tors (the bottom part of a fraction).

Figure (number) Types: Tabular figures are all of equal 
width. ey are only needed when the figures must all 
line up from one line to the next, as in a table. Propor-
tional figures have varying widths, just like most let-
ters; each number has a width appropriate to its design. 
Unless there is a special need for tabular figures, you 
should use proportional figures.

Lining figures are all the same height, usually similar to 
that of capital letters. ey are needed only for use with 
all-capital settings, or when a particularly modern look 
is desired. Oldstyle figures are of varying height. ey 
are appropriate for use with lowercase or mixed-case 
text, and especially if a classic or refined look is desired.

lining oldstyle

tabular 0123456789 
proportional  

Default figures are whichever type are encoded as the 
standard figures in the font. For historical reasons, these 
will be tabular lining figures, though the decision is 
up to each font manufacturer. Because tabular lining 
figures are not the best choice for most documents, we 
recommend actively choosing figure types for each par-
ticular usage.

The Glyph Palette

While OpenType layout features are primarily accessed 
via the OpenType menu, Adobe InDesign also allows 
you to view and access all of the possible glyphs and 
layout features in an OpenType font through a single 
window. 

1  Insert your cursor in a text box.

2  Select Type > Insert Glyphs…  e Glyph Palette will 
appear.

3  Select a font in the font selection field. Select the 
appropriate font weight or style in the style selection 
field. All of the possible glyphs in the font will appear.

 You can also click on the size icons to increase or 
decrease the point size of the glyph samples in the 
window.

 If there are alternate forms of a glyph available via an 
OpenType layout feature, a small triangle will appear 
in the lower right corner of the glyph cell. Clicking 
and holding on such a glyph cell will activate a flyout 
showing all the alternate glyphs. 

4  Double click on a glyph cell, or if there is a flyout, 
click-hold and select the desired alternate glyph. e 
glyph will then be inserted in your document wher-
ever your text cursor was positioned.

You can filter the glyphs displayed in the dialog by using 
the OpenType layout features pop-up menu. is pop-
up menu will display all of the substitution features sup-
ported by the currently selected OpenType font. Aer 
choosing an OpenType font in the font selection field, 
select a layout feature, such as discretionary ligatures 
or swash, from the pop-up menu and the dialog will dis-

Font selection field
Glyph selection flyout

Show OpenType layout features

Style selection field

Change display size

Alternate glyph 
indicator
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You can view only the alternate glyphs available for a 
single selected glyph in your InDesign document by 
selecting “Alternates for Selection” from the “Show” pop-
up menu of the Glyph Palette. (If more than one glyph 
is selected, the Glyph Palette will show no alternates.)

InDesign will remember the last OpenType layout 
feature you used the next time you activate the Glyph 
Palette. To return to a view of all the glyphs in the font, 
select Entire Font from the pop-up menu. For more 
information about the Glyph Palette, please refer to the 
InDesign documentation.

Note: Adobe advises selecting alternate glyphs by applying 
formatting, when possible, rather than using the Glyph 
Palette. Using formatting sometimes yields more consis-
tent results when changing fonts.

play only those glyphs that are available through that 
layout feature.
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